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This is the documentation for the Check Printing software.    Please select one of the 
following sub-topics for additional information:

Overview of the software
Additional Software
Help Strategy
Revision History

Dedications:
Corinne, who thought I'd invented the software equivalent of a Tinker Toy.
Ron, who volunteered to be 'one of the first'.
David, who was right in line behind Ron.

In addition to the prescribed methods of contacting me, I may be contacted through a 
Bulletin Board known as Companion and Friends 1-714-521-9598, my account number 
there is 282.



Overview of Checkprint software

The CheckPrint software allows the user to print checks on a variety of printers.    Currently, I 
am using an Hewlett Packard LaserJet IIP to print my checks on.    The Checkprint software 
makes extensive use of DDE (Dynamic Data Exchange) to obtain information regarding the 
check from cooperating software.    A brief description of this software is described under the
heading of Additional Software.



Additional Software

The Checkprint program represents only a piece of a much larger software product.    
Additional programs are available which intercommunicate with the checkprint program.    
For additional information select one of the following:

CheckBook
CheckWrite
BillManager



Help Strategy

Throughout the checkbook program every attempt has been made to document each and 
every field which the user can either view or modify.    Often times, this appears to be 
overkill, but it is done in keeping with the general design concept of the help system.

 Contextual Help is available from anywhere within the program.    By pressing 
SHIFT+F1 or by selecting the Help Contextcommand Contextual Help mode is enabled.    A 
context Cursor is displayed to indicate that you are in Context Help mode, additionally, the 
Caption Bar is changed to reflect this information.    While in Context Help you may position 
the cursor on any field and click the left button for detailed information regarding that field.   
You may also click on the Caption Bar for general information about the specific window that 
the Caption is for.



Revision History

Version 1.0 Initial Release, March 19, 1991
Version 2.0 Released April 4, 1991
Version 2.1 Released April 12, 1991
Version 2.2 Released April 19, 1991



Checkbook

The Checkbook software assists in the management of a checking account.    It allows you to 
enter Credits and Debits, and to get an updated running Balance as well as a monthly 
Statement Balance.    This program works in conjunction with the CheckWrite and 
BillManager.



CheckWrite

The CheckWrite software allows the user to write 'hand checks' updating the Checkbook and 
printing the check using CheckPrint.    Hand checks are any checks which are not generated 
by the BillManager.



BillManager

BillManager is a software product which keeps track of all of your regular bills in a cardfile 
type fashion.    You may select a bill to pay, or have the software prompt you when a bill is 
due.    It will cause the updating of the Checkbook and print the check using the CheckPrint 
products.



Version 1.0, March 19, 1991

This is the first release of the software.    Although extensively tested, it is the first release.    
I've been using it for about 2 months without any problem, so it is basically stable.    While I 
do anticipate revisions to the software, it appears to be complete.    If you have any 
suggestions for changes, enhancements, or if you find any problems you may contact me at 
the address or phone number specified in the Software 
RegistrationHELPID_DIALOG_REGISTER form.



Version 2.0, April 4, 1991

I've changed the DDE interface a bit.    Now, if/when the CheckPrint program goes 
away, any programs that were talking to it are notified.



Version 2.1, April 12, 1991

I've tightened up the program security a bit.    Maybe this will make it less prone to 
being crock'd.



Version 2.2, April 19, 1991

I've corrected a visual problem with the ICON.

Opps...    Seems that if you click on the arrows when there aren't any bills things go 
wrong.    Well, this should fix it.

I've changed the DLL that manages all of the File Dialogs.    It now provides some 
information about the type of file being manipulated in the Caption.



Dialog:Software Registration Form

Completing this form and mailing it to the directed address, along with the amount of money
specified allows you continuing use of this software package.

For more details select one of the following fields:

Package Name
Package Price
Mail From

Name
Address
City
State
Zip
Phone

Media
3 1/2 Disk
5 1/4 Disk

Add to Mailing List
Obtained From

BBS
Friend
Vendor
Show
Name
Phone

Action
Print



Text:Package

This is the name of the software package that you are registering for.



Text:Price

This is the price of the software package.    In U.S. Dollars, this may be either in the form of a 
check or money order made payable to the name contained in the 'Mail To' box.



Edit:Name

This is your name, or the name of the company who wishes to register the software.



Edit:Address

This is your address or the address of your company.



+Edit:City

This is the city in which you or your company is located.



Edit:State

This is the state in which you or your company is located.    This is also where the Country is 
specified for non-US states.



Edit:Zip

This is your ZIP code (Zoning Improvement Plan - for those trivia buffs).



Edit:Phone

This is your phone number, including area code and country code if you are outside the 
United States.



Button:3 1/2 Disk

This button is used to indicate that you want software shipped on 3 1/2 inch disks.



Button:5 1/4 Disk

This button is used to indicate that you want software shipped on 5 1/4 inch disks.



Toggle:Add to Mailing List

Check this box if you want to be added to the mailing list.    This is how you find out about 
new versions of software as well as other additional products.



Button:BBS

This button is used to indicate that you obtained this software from a BBS (Bulletin Board 
System).    Although not required for registration, this information will be helpful in 
completing this form.



Button:Friend

This button is used to indicate that you obtained this software from a friend.    Although not 
required for registration, this information will be helpful in completing this form.



Button:Vendor

This button is used to indicate that you obtained this software from a vendor.    Although not 
required for registration, this information will be helpful in completing this form.



Button:Show
This button is used to indicate that you obtained this software from a show.    Although not 
required for registration, this information will be helpful in completing this form.



Edit:Name

This is the name of the BBS, Friend, Vendor, or Show that you obtained this software from.    
Although not required for registration, this information will be helpful in completing this 
form.



Edit:Phone

This is the phone number of the BBS, Friend, Vendor, or Show that you obtained your 
software from.    Although not required for registration, this information will be helpful in 
completing this form.



Action:Print

This action button is selected after you have completed the registration form.    It will print 
the form on your printer.    If you don't have a printer, then write the information on paper 
and send it along with your remittance.



Message: Replace existing filename

This message is issued when, as the result of a file saveas command, you would overwrite 
an existing file.

Actions:
YES Causes the file to be overwritten, completing the file saveas command.

NO Causes the file saveas command to be aborted without overwriting the existing 
file.



Message: Save Current Changes filename

This message is issued when, as the result of a File New, or File Exit command, or any other 
command that replaces file data, would potentially cause you to lose your modifications.

Actions:
YES Causes the file data to be saved, and then completes the requested 

command.

NO Causes the file data to NOT be saved, and then completes the requested 
command.

CANCEL Causes the    requested command to be aborted leaving the file data intact.



Dialog: File Open

The File Open dialog box provides the user with a means of specifying the file to be read.    
For additional information, select one of the following:

Objects:
FileName
FilePath
FileList

Actions:
Open
CANCEL



Edit: File Name

This is the name of the file to be opened.    It is appended to the File Path to form a full file 
specification.



Text: File Path

This is the path to the file being specified.    It is prepended to the File Name to form a full file
specification.



Listbox: File List

This listbox contains all of the files and directories which can be selected as the File Name 
and File Path.



Action: Open

Opens the specified file for input into the program, replacing or augmenting the existing file 
data.



Action: Cancel

Cancels the file opening, and returns with the file data still intact.



Dialog: File SaveAs

The File SaveAs dialog box provides the user with a means of specifying the filename    that 
the file data is to be saved under.    For additional information, select one of the following:

Objects:
FileName
FilePath

Actions:
Save
CANCEL



Edit: File Name

This is the filename the file data is to be saved into.    It is appended to the File Path to form a
full file specification.



Text: File Path

This is the path to the file being specified.    It is prepended to the File Name to form a full file
specification.



Action: Save

Saves the file data into the specified file.



Action: Cancel

Cancels the file SaveAs, and returns with the file data still intact.





Menu:File

The File menu includes commands that enable you to open and save check layouts, 
establish a new check layout, print the check layout.    Additionally, to register the software 
and access the Layout.

For more information, select the File menu command name.

NEW
OPEN
SAVE
SAVEAS
PRINT
REGISTER
EXIT



File New Command

Initializes a new check layout.    If there are changes to the current check layout the Save 
Current Changes message will be invoked.



File Open Command

Opens an existing check layout.    If there are changes to the current check layout the Save 
Current Changes message will be invoked.    A file open dialog box is presented to the user to
assist in the selection of the file.



File Save Command

Saves the current check layout back into the file that it came from, overwriting the previous 
contents.



File SaveAs Command

Presents the user with a SaveAs file dialog box allowing for the specification of the file that 
the check layout is to be saved into.



File Register Command

Activates the Software Registration dialog box.    By completing this dialog and mailing it, 
along with the registration fee you are provided a registered copy of this application.



File Print Command



File Exit Command

Exits the application.    If there are changes to the current check layout the Save Current 
Changes message will be invoked.



menu ALIGN command

Selecting this menu item causes the Alignment Dialogbox to be presented.



Dialog:Align

This dialog box allows you to specify where the printer will start printing.    Many printer are 
not able to print on the exact edge of the paper.    This provides a means of specifying how 
far down and over the printer can start to print.    For example, the HP LasetJet IIP starts 
printing 0.25 inches down and 0.25 inches over.    For further information, select one of the 
following:

Edits:
Inches from Top
Inches from Side

Actions:
Accept
Forget



Inches from Top

This edit field allows you to specify how far from the top of the check the printer will actually
start to print.



Inches from Side

This edit field allows you to specify how far from the right side of the check the printer will 
actually start to print.



Action:Ok

Select this action button once you have reviewed the measurements and are satisfied with 
them.



Action:Cancel

Select this action button once you have reviewed the measurements and are not satisfied 
with them.    Selecting this will cancel the changes that you have made.





menu OBJECT command

Selecting this menu item causes the Object Dialogbox to be presented.



Dialog:Object

This dialog box allows you to specify where on the check to print the various fields.    For 
further information, select one of the following:

Objects:
Date
Year
Payee
Print Amount
Written Amount
Memo

Edits:
Inches Down
Inches Over
Inches Long

Actions:
Accept
Forget
Close



Objects

This allows you to select which object you wish to place on the check.    Each possible object 
is represented in this combobox.    For additional information select one of the following:

Date
Year
Payee
Print Amount
Written Amount
Memo



Inches Down

This edit field allows you to specify how far down an object is to placed on the check.    The 
measurement is in inches and is taken from the top of the check to the baseline of the field.



Inches Over

This edit field allows you to specify how far over an object is to placed on the check.    The 
measurement is in inches and is taken from the right of the check to the begining of the 
field.



Inches Long

This edit field allows you to specify how long an object is tobe.    The measurement is in 
inches and is taken from the right of the field to the left of the field.



Action:Accept

Select this action button once you have reviewed the measurements and are satisfied with 
them.



Action:Forget

Select this action button once you have reviewed the measurements and are not satisfied 
with them.    Selecting this will cancel the changes that you have made.



Action:Close

Select this action button once you have reviewed all of the changes and are satisfied with 
the placement of the objects on the check.



Menu: Help

The Help menu includes commands that enable you to obtain help regarding various 
features of the checkbook.

For more information, select the Help menu command name.

Context
Overview
Index
Using Checkbook
About



Help:Context Toggle

Selecting this item has the effect of toggling contextual help on and off.    When Contextual 
help is on the Context Help Cursor is displayed.    When it is off the normal cursor for the field
is displayed.    By positioning the cursor and clicking the left mouse button you can receive 
detailed information regarding the particular item.



Help:Overview Command

Presents an overview of the Checkprint program.



Help:Index Command

Presents a Help index for the Checkprint program.



Help:Using Help Command

Provides the user with information on how to use the help system.



Help:About Command

Displays the About dialog box.



Dialog:About

This dialog box presents general information to the user regarding the software being run.    
For further information select one of the following commands:

Actions:
OK



Action:OK

Select this action button once you have reviewed the About dialog box to remove it and 
return to the application.



This is the date field, the Month and Day will be placed here.



This is the year field, the Year will be placed here.



This is the payee field, this is where the Pay to the Order goes.



This is the printed amount of the check.    An example is 15.23



This is the written amount of the check. An example is Fifteen and 23 cents



This is where the memo is written on the check.



 This is the cursor that is displayed when context sensitve help is enabled.


